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The Edmark Story 
In the late 1960's, a group of educators at the University of Washington developed a 

dramatically different way to teach reading. This new method was remarkably successful 

with students who had met with failure in other programs. By slowly building skills, It 

ensured success and a feeling of confidence. The students who used this method began 

to believe in themselves and in their ability to read. 

In 1970, the Edmark Corporation was formed to make the reading method and other 

quality educational products available to a broader market. Edmark’s mission was to apply 

advanced educational concepts to the development of quality classroom materials. Since 

then, Edmark products have been used extensively in classrooms nationwide, and teachers 

have been vocal in their praise. “So much magic in one box!” wrote one, “Some of my 

students wouldn't be reading without Edmark’s help.” 

Twenty years later, Edmark continues to find new ways of empowering young children 

to learn. Computers provide an exciting new tool for learning. Managed by educators, 

Edmark is leading the way in developing engaging, creative software based on proven 

educational concepts. 

Now you can possess the same Edmark expertise that teachers have relied on tor more than 

two decades. Edmark’s Early Learning Software provides a captivating method for using the 

home computer to help your child to learn. Millie’s Math House, Bailey's Book House, and 

KidDesk are the first in a growing family of products designed specifically for young children. 

At Edmark, we're driven by the wondrous look of children learning something new. Our 

goal is to ensure that if Edmark’s name is on the box, there’s a world of learning inside. 



Macintosh Guide 

KidDesk gives kids a place of their own on the computer—a personalized, colorful desktop 

that lets them launch their own programs but keeps them out of any adult programs not 

selected for their use. Every desk includes lots of fun desk accessories—like a 13-month 

calendar, a calculator, a message machine, and a talking clock. With KidDesk, parents no 

longer have to worry about letting young kids use their computer! 
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Welcome to KidDesk! 

Children need opportunities to explore, experiment, make decisions, take 

succeed, and—most important of all—to learn. A rich and varied environme 

ish their development. 

outers become an increasingly important part of this environment, children can begin 

life to enjoy and benefit from using the computer as an engaging, highly interactive 

ving tool. KidDesk was designed to enable your children to use the computer freely and 

independently—to gain confidence and self-esteem —without placing your own valuable 

data at risk. 

Children are eager to use the tools that they see grown-ups use. With KidDesk, your child 

can learn real-life skills using an assortment of fully functional desktop accessories. There's a 

calculator, a talking analog/digital clock, a phone with a message recorder, and a pe! 

calendar with colorful stickers for special dates. 

Because “one size” never really fits all, KidDesk provides options for you to create a uni 

nd personal desktop that is just right for each child. You control which applications on your 

d disk each child can access. You may also want to turn off all of the desk accessories and 

e children begin by just using KidDesk as a personalized program launcher. One by one, 

9u can add and explain how to use each accessory and watch their surprise and delight at 

each new addition. (It’s almost like bringing home three or tour new programs.) 

We want to help you in your role as your child’s first teacher by providing software that 

combines leading-edge technology, proven educational methods, and a sense ot joy in 

learning, to ensure success for your child. Listening is a vital part of our development process. 

We listen to parents, children, teachers—and we really want to listen to you. Please drop us a 

line, describe you and join us in helping children use the power of technology to 

increase their le jal! 

The Edmark Development Team 



Getting Started 

What's in this package? 

KidDesk Guide 

Registration Card 

1 Program Disk 

Product Brochure 

What do you need? 

» Macintosh Plus or later 

» System 6.0.7 or later (with MultiFinder off) 

System 7.0 or later required for some features 

= Memory: 

System 6.0.x—1 MB tor monochrome; 2 MB for color 

System 7.0 or later—2 MB for monochrome; 4 MB for color 

# Hard disk 

Remember... 

Return your registration card today. 

Read the rest of this Guide so you can help your child use KidDesk to its fullest potential. 

Consider optional hardware: 

» Printer—Print monthly calendars with your child's notes and reminder stickers. 

= Sound-input device—If your Macintosh does not have built-in sound input, you can add a device 

to record sound and speech. 

= TouchWindow—A removable touch screen that provides direct, easy input for very young children 

or children with special needs. The TouchWindow Is available directly trom Edmark Corporation, 

(206) 556-8484. 

= Scanning device or video camera —If you have a hand-held or flat bed scanner or a camera with 

video digitizer, you can place a photograph in the Picture Frame on your child's desk. 

a 



Installation 

The Installer automatically checks your system software, memory, and monitor and then selects either 

the color or black and white version to install. Use Custom Installation to override the automatic 

selection. For example, choose Customize in order to install the black and white version, which 

requires less disk space. Follow these steps to install KidDesk on your hard disk: 

1. Quit all applications that are open. (Note: System 6 users must turn MultiFinder oft.) 

2. Insert the disk labeled “Installation Disk” into your disk drive. 

3. When the KidDesk window appears, double-click 

4. Click on the KidDesk Installer title screen. [easy insta 

5. For Easy Installation, click (_instan_}), 

and proceed to step 6. on the hard disk named 

(OR) = Your Hard Disk 

For Custom Installation, click | pcan tan 

Select either “Color” or “B&W.” Then, | 

click (cisstan}), and proceed to step 6. eee ee ee 

6. When the screen indicates that installation was successtul, click 

7. To set KidDesk to run automatically each time your computer is turned on, do the following: 

System6 ~— = Open the KidDesk folder on your desktop. | 
Select (by clicking once) the “KidDesk Startup” icon | 
Choose Set Startup from the Special menu. KidDesk Startup 

= Click “Finder,” and click “KidDesk Startup.” 
= Click _ then choose Restart from the Special menu. 

(To undo automatic running: Choose Set Startup, and click “Finder” and “Finder Only.”) 

System 7 ~— = Open the KidDesk folder on your desktop, then select gay . 
= Choose Make Alias trom the File menu. KidDesk Startup 
= Open the System folder, and drag the KidDesk Startup alias into the 

Startup Items folder in the System folder. 
= Drag any other icons out of the Startup Items folder. 
Choose Restart from the Special menu. 

(To undo automatic running: Drag the KidDesk Startup alias out of the Startup Items folder.) 

Running KidDesk automatically provides maximum hard disk protection for you while 
allowing your child the most independent access. 



Quick Setup 

No quick list can introduce every option available in KidDesk. However, after you have installed the 

program, if you take fifteen to twenty minutes, you can quickly become familiar with KidDesk and 

set up a personalized desk for your child. 

Explore KidDesk: To run KidDesk, open the KidDesk folder on your desktop, then double-click »¥¥ 

Use Program Overview (pages 6-7) to explore the program. KidDesk Startup 

Personalize KidDesk: To set up a personalized desk for your child, follow these steps (see pages 

18-28 for complete instructions): 

1. Hold down the Option and Command & keys and press “A” to enter the Adult Section. 

2. Click the “Kids” tab to see the Kids Card (if It is not showing), then choose Add Kid trom 

the Kid menu. 

=» Type your child’s name. 

= Click{ Change | then select a new icon. 

= Click ({_Record } to record a Welcome Message for your child. 

= Click when finished. 

3. Click the “Applications” tab to see the Applications Card, then choose Add Applications 

from the Application menu. 

= Select the application you wish to add to your child’s desk (to add several applications, hold 

down the Command # key while you select the applications), then click . Use 

to add applications from other drives. 

4. Choose Kid Exit Option trom the Options menu. 

= Click the desired exit option for your child. (If you choose “Allow Exit to Finder,” your child 

will be able to access your Macintosh desktop and hard disk.) 

Enjoy KidDesk: Choose Return to Kid Section from the File menu, and invite your child 

to use KidDesk! 



PROGRAM Ov ERVIE W 

Kid Section 

--- Screen Saver (page 10) 
Guest Icon (page 10) Click to activate Screen Saver. 
Click icon to go to Guest desk. = 

N 
nN 

ExitIcon(page 10) , eg es = Kid Icons (page 10) | 

Click to leave KidDesk. Click icon to go to desk. 

Pencils and Pens (page 13) Picture Frame (page 12) Calendar (page 16) 

Select a different style See your child’s icon and hear a Welcome _-7~ Use a monthly calendar 

ot desk. ‘Message (if one has been recorded). a and day box. Enter notes 

: or reminder stickers on 2 

specific days. 
Mon Tue Wed Thu Fri Sat 

£ |2- 49-34 

Calculator (page 14) ----~~~" 

Use a large, on-screen 

calculator. 
» Lamp (page 13) 

Dim or brighten the screen. 
7 

7 Name Plate (page 12) 

Switch between first 
\ 

name only or first and Arrow 

last names. e | See more applications. 

Stop Sign oe Applications (page 11) Clock (page 14) " Phone and Recorder (page 15) | 

Return to the Run an application or See a digital clock Record a message, and hear the 

Opening Screen. see documents and hear the time phone play it back. 

created by your child. spoken. 



Adult Section 

Hold down the Option and Command & keys while you press "A" to enter the 

Adult Section of KidDesk. Use the Adult Section to set up a desk for your child. 

The Adult Section Window 

Click the “Kids”. 

tab to see the Kids 

Card and to use 

the Kid menu. 
| 

Joseph Friesen 

Kids you add-.-~=-< 

will appear on 

this card. 

- Click the “Applications” tab to 

see the Applications Card and to 

use the Application menu. 

]---KidDesk menu bar 

Writing 

-- Applications you 

add (from your hard 

disk) will appear on 

this card. 

The KidDesk Menu Bar File Edit Kid Application Options 

_ Use the KidDesk menu bar to change kid and application settings and to control other features. 

File menu (page 19) 

= Return to Kid Section. 

= Set up printer and page. 

= Activate Finder or Quit to the Finder. 

= Shut down. 

Edit menu (page 19) 

# Edit text and graphics. 

Kid menu (page 20) 

# Add or remove a child. 

# Change name, icon, and Welcome Message. 

® Control scanning functions. 

# Limit the applications your child can use. 

= Control your child’s documents. | 

Application menu (page 25) 

# Add or remove applications. 

= Change an application’s name in KidDesk. 

# Run application with Finder active. 

= Turn document collection on or off. 

Options menu (page 26) 

= Add or change an Adult Section password. 

= Control the Screen Saver. 

= Select your child’s exit option. 

= Set a Time Reminder for your child. 

# Add and remove KidDesk accessories. 
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Kid Section 
The Opening Screen 

The Opening Screen 

The icon and name of each child added to KidDesk appear on the Opening Screen of the Kid Section. 

To identify themselves, children just click their own icons. Before you add your child to ee (see 

Add Kid, page 20), only the Guest icon will appear on this screen. 

Before you add your child: After you add one or more children: 

Joseph Friesen 

You can disable the Guest icon (see Guest Settings, page 23); however, you may wish to leave it in so 

that visiting friends can use KidDesk without affecting your child’s desktop. 

To go to the Guest or Kid's desk, click the Guest or Kid's icon. 

To activate the Screen Saver, click the KidDesk logo. To return to the Opening Screen, move the 

mouse or touch any key. 

The Screen Saver will also appear anytime that there is no mouse or keyboard activity for tive 

minutes. You can turn this function off or on and set the length of time after which the Screen 

Saver will appear (see Screen Saver, page 26). The Screen Saver will not appear while your child is 

running an application trom KidDesk or while you are using the Adult Section of KidDesk. 

To exit KidDesk, click the computer icon (if displayed). Using the Options menu of the Adult Section 

(see Kid Exit Option, page 26), you can enable one of three exit options: 

# Don’t Allow Exit: There is no computer icon. (You must exit trom Adult Section.) 

# Allow Exit to Finder: The computer icon‘s screen is colored or white. 

# Allow Shut Down: The computer icon’s screen is black. 



Kid Section 
The Desk 

The Desk 

The desk Is your child’s “home base.” From here your child can use the accessories (Calculator, 

Clock, Phone, etc.) and run applications. You control the name, icon, accessories, and applications 

that appear on your child's desk. 

Before your child and applications are added: After your child and applications are added: 

Applications you add (from your hard disk) appear here. 

Applications (the programs that your child can use) 

Add as many applications to your child's desk as you like (see Add Application, page 25). Your 

child will have access to the applications that appear on the desk, but will not be able to run any 

other applications on your hard disk. To run an application, your child clicks an application on the 

desk. After quitting the application, your child will return to the desk (if using System 6, your child will 

return to the Opening Screen). 

Document List (System 7 or later required) 

If your child has created documents while running an 

application from KidDesk, those documents will appear 

when the application’s icon on the desk is clicked. 

You can add and remove documents from your child's 

document list (see Kid’s Documents, page 24). 

# To open a document, click the document's icon. 

# Torun an application, click the application’s icon. 

# To return to the desk, click 



Kid Section 

The Accessories 

The Accessories 

KidDesk has six different desk styles. Each desk offers nine accessories—Name Plate, Picture Frame, 

Lamp, Pencils and Pens, Clock, Calculator, Recorder, Phone, and Calendar. To use an accessory, Just 

click it! (Some accessories may be removed or added to the desk, see KidDesk Accessories, page 27.) 

Name Plate 2 [rat risen 

The Name Plate identifies the owner of the desk and displays either the first name Soa or the first 

and last names. 

= Click the Name Plate to switch between first name only and first and last names. 

a See Add Kid (page 20) to enter a name. 

Picture Frame 
oe aeren ice cen “avienemei tel Mics ley wiiet cemeatenl er ied) prey gciey sae). em ure (recy ae), io aye’™ Me’ vel (0, @yre: sce er Wreid- ter). Jeeta tier vie) Mier #56) 21ers Ole e483) Oe nen a 1@yy bie a OC Sey Ol Fiemme 18Pd OCT Aer sO weks HOt Spader Sk wer Pee tg Oe re ego 

The Picture Frame displays a personal icon for your child. You can choose one of KidDesk’s 50 

icons; you can draw your own icon in KidDesk’s icon editor; or you can import a picture (such as a 

paint document or a digitized photograph) from another program. Clicking the Picture Frame will 

also play a Welcome Message, if you have recorded one. 

= Click the Picture Frame to play the Welcome Message. 

a See Record Welcome Message (page 20) to record a Welcome Message. 

» See Choose Icon (pages 21-22) to select, create, or import an icon. 



Kid Section 

The Accessories 

The Lamp is just for fun. Use the KidDesk Lamp to turn down the light on the desk. 

Click the Lamp to dim the screen. 

# Click It again to brighten the screen. 

Pencils and Pens 
OM SON eI (Bie ier Reick tei is eacierae ee alee. ermine nel 187, ese (oy Penis ieiy e:) Siev ey Hoge et 1:0. “ery Vien se) ie. “ie: fe)” ce: ayers)" Neh efsien. ies ier oiey. WA bet wee Lier ciel en fel aie? fal es bvied, ah o'er seh sew ver ces Me to ae ee 

The Pencils and Pens (or Paints) allow your child to choose a new style of desk. Although the “look” 
changes, anything specific to your child (such as name, applications, icon) remains as a part of the 
new desk. 

# Click the Pencils and Pens to see 

the desk choices. 

= Click 
do not want to change desks. 

# Click the desk that you want to 

replace your current desk. 



Kid Section 
The Accessories ; 

The analog Clock uses hour, minute, and second hands to show the time. Your child can also see 

digital and analog clocks simultaneously and hear the time spoken. (The Clock displays the time 

set on your Macintosh internal clock. See the Macintosh User’s Guide tor information on setting 

the time.) 

= Click the Clock to see a digital clock and hear the time spoken. 

“The time is seven fifty-one.” 

The Calculator allows your child to access the large, on-screen calculator. Use the KidDesk Calculator 

as you would a standard calculator. 

8 Click buttons on the Calculator, or use your keyboard (use the clear key for C; use the / key for +; 

use the * key for X) to operate the Calculator. 



Kid Section 
The Accessories 

Recorder 

The Recorder allows you or your ane to record a message Gf your computer is equipped with 

a microphone). Record anything you would like—a reminder, a funny noise, a riddle, a bit 

of encouragement. 

= Click the Recorder on the desk. 

Record Stop Pause Play 

seconds 

a Click| @ | to begin recording. Click | | when Tinished. 

Fi Click] » |to hear what you recorded. 

B® Click to save the newly recorded message and return to the desk. 

Phone 
ee ee iS FO Oe 8 pt EOD Oe HO nO 0 OO OF 18) 70h, Os, TR: 6 (Ot Os Ot 6 MONS) Or 8h maS a 8, 10 8. fe CO. HO 8 LO) siti ep ue en ne et tie) ol “el he) ees See ce) let, et iepe ie: ser ie ce eu, fer oe) er te ek fer Oe (eh wer lies se. en, eye ce: 

The Phone plays the message recorded using the Recorder. Your child will hear an “off hook” signal if 

no message has been recorded. If you do not have a sound-input device, or if the Recorder is set to 

“Use Built-in Sounds,” the Phone will play a variety of greetings (see KidDesk Accessories, page 27). 

= Click the Phone to hear the message. 

“Susan Is coming over to play today.” 



Kid Section 
The Accessories ’ 

Calendar 
on arm Lat cen len iow se. cool cee ie: afereaecige® ter ecie: cer Yet =cel isa) nemuter? eeu uere jeer 0) § ernie es) nel te ele rer er se, BO) OA ee, NOt TO ek 10; gOle, 10) 10 ee Cr Os Ore WO Ore Ol ae Or ee 1Ot AO re) [Oy Or Oh ws 10h Oh Se JO lO AO Reel 18 eg Or oe 1S AC Sak 9 ene ee, 

The Calendar on the desk shows the current date. Click it to view the calendar for the current month, 

the previous month, or one of the following 12 months. 

® Click the Calendar to see the monthly calendar and day box. 

2 13 /4 | 

Reminder Stickers - - -- 

Return to desk.- -~7 i---- See next month. 

Print monthly calendar. Return to current month and date. 

See previous month. 

= Click a day to select it. Your child can enter notes or place reminder stickers on that day. 

-To place a reminder sticker, click it. The sticker will appear in both the day box and the 

monthly calendar. To remove it, click the blank reminder sticker. 

-To enter a note in the day box, type it on your keyboard. The monthly calendar will indicate 

a note has been entered. 

If a note or reminder sticker has been entered for a particular date, an alert box with the note or 

sticker that was on the calendar will appear when the desk is used on that date. 

= Click Gui 
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The Adult Section Window 18 

Quit to Finder 
Shut Down 

File Menu 

Undo #2 

Edit Menu 

Kid 

Add Kid... 

Remove Kid 

Kid Settings... 

Limit Applications... 

Kid’s Documents... 

Kid Menu 

Application 

Add Applications... 
Remove Application 

Application Settings... 

Options 

Adult Password... 

Screen Saver... 

Kid Exit Option... 

Time Reminder... 

Options Menu 
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19 

19 

20 

26 



Adult Section 
The Adult Section Window : 

Enter the Adult Section by holding down the Option and Command 32 keys while 

you press “A.” You can also add a password as an extra security measure (see Adult 

Password, page 26). 

The Adult Section includes the Adult Section window (Kids and Applications Cards) and the 

KidDesk menu bar (File, Edit, Kid, Application, and Options menus). Use the Adult Section to set up a 

personalized desk for your child and to control other KidDesk options. 

The Adult Section Window 

The Adult Section window displays the Kids Card or the Applications Card. The Kids Card displays the 

kids you have added to KidDesk, and the Applications Card displays applications on your hard disk 

that you have selected to work with KidDesk. 

= Click the tabs to switch between the Kids Card and the Applications Card. 

After you add kids to KidDesk: After you add applications to KidDesk: 

| Applications Applications 

Pat 
Friesen 

Reading 

Applications you add (from your hard disk) appear here. 

» When the Kids Card is showing, you can use the Kid menu to add a kid. To remove a kid or 

modify a kid's settings, select the kid's icon, then choose an item from the Kid menu (pages 20-24). 

= When the Applications Card is showing, you can use the Application menu to add applications. 

To remove or modify applications, select the application's icon, then choose an item from the 

Application menu (page 25). 

= The File, Edit, and Options menus can be used with either card showing. “= a: 



File Edit Kid Application Options 

Return to Kid Section #K 

Activate Finder™ 

Page Setup... 

Printer Setup... 

Quit to Finder 

Shut Down 

Edit 

Undo 32 | 

Select All a6 

Adult Section 
File & Edit Menus 

The KidDesk Menu Bar 

The KidDesk menu bar is the control center of the KidDesk 

Adult Section. Using the five menus (File, Edit, Kid, Application, 

and Options), you can control every aspect of the desk that your 

child uses. 

Many of the KidDesk menu items display a dialog box. In a dialog 

box, you can enter or change information. Click to save any 
changes you make and close the dialog box. Click to close 
the dialog box without saving any changes and to retain the 

previous settings. 

File Menu 
Return to Kid Section: Return to the Opening Screen of the 

Kid Section. 

Activate Finder (System 7 or later required): Use the Finder (the 

program that operates the Macintosh desktop) without quitting 

KidDesk. You must activate the Finder to use the Chooser, Control 

Panels, and other items in the Apple menu. 

Page Setup: Select paper size, image enlargement, and printer 

effects for your child’s calendar printout. (Options vary depending 

on printer.) 

Printer Setup: Select options for your child's calendar printout. 

(The options may vary depending on the printer you have chosen.) 

Quit to Finder: Exit KidDesk and return to the Finder. 

Shut Down: Exit KidDesk and shut down the computer. 

Edit Menu 
The Edit menu contains the items (Undo, Cut, Copy, Paste, Clear, 

and Select All) that are used to edit text and graphics. Refer to your 

Macintosh User’s Guide for further information. | | 



Adult Section 

Kid Menu 

Kid 

Add Kid... 

Remove Kid 

Kid Settings... 

Limit Applications... 

Kid’s Documents... 

H. —Scannin 

/ Record Stop Pause Play 

| o seconds 10 

Kid Menu 
Click the “Kids” tab to see the Kids Card (if it is not showing) and to 

use the Kid menu. 

Add Kid 
To add a new kid, choose Add Kid from the Kid menu. You can also 

choose an icon, record a Welcome Message, and select scanning 

options (see KidDesk for Special Needs Users, page 28). 

You may find it useful to create fictional kids whose desks hold 

specific groups of applications. For example, you might create 

one kid who has all games and another kid who has only 

math programs. 

Name 

First Name: 

Enter name(s).----- | | _~ Change icon. 
& Last Mame: 

Scanning 

Scan Rate: GE 

Turn scanning ---- | 

On/OfTt. 

| -- Set scan rate. 

| (fastest) 7(slowest) 
- 

- 
- 

- 

E' Welcome Message 
es : 4 

es | Currently: None : 
- 3 : 

ee Erase Record 
1 

Change scan ===--=- 1-- Record a welcome 

progression. le eee «| ESSAge. 

Save the new kid and all settings, 

and return to Adult Section window. 

Return to Adult Section window 

without adding the new kid. 

Record Welcome Message: Click from the Add Kid 

dialog box to record a Welcome Message. The message you record 

will be played when your child enters the desk and when the Picture 

Frame is clicked. 

= To begin recording, click @ | _ Click || when finished. 

= To hear what you recorded, click Lp |. 

a To save your newly recorded message and return to the Add Kid 

dialog box, click (save _}. 



Import Pict 

(J Dither i 

Select 

© Fixed Area i 

i 
@ Variable Area i 

i 

Adult Section 

Kid Menu 

Choose Icon: Click trom the Add Kid dialog box to 

choose a new icon. 

= To see more Icons, use the scroll bar. 

= To choose an icon, select it, then click («_). 

Import Picture: Click to import a PICT file. A PICT file 

IS a specitic kind of file created by a paint or graphics application 

and may contain a photograph you have scanned or a picture you 

have drawn, etc. 

= Select the name of the file, then click (tven_)). 

The Import Picture dialog box will appear. Use it to select the area of 

the Tile that you want to use as an icon. You have two options: 

1. Fixed Area: Drag the icon-sized box over the area you want to 

use (releasing the mouse button selects the area). 

2. Variable Area: Drag to draw a box around any part or all of 

the picture. That area is reduced or enlarged to fit into the 

icon frame. 

- Normally, dragging will be restrained (retaining the correct 

aspect ratio and avoiding distortion) to fit the picture into 

the frame. 

- If you hold down the Shift key, you can drag freely, but the 

image may be distorted when fit into the frame. 

Use the Dither check box to maintain color consistency when 

reducing or enlarging images with the Variable Area option. 

& 



Adult Section 

Kid Menu 
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Cancel | | 

lan Joseph has 4 documents. 

Do you want to: 

* Delete them, or 

® move them to a folder on the desktop called ' 

“lan Joseph f"? : 

Customize Icon: Click (Customize } from the Choose Icon dialog box 

to create your own icon or to create a customized copy of the icon 

currently shown. 

= 10 select a tool, click It. 

Pencil: Draw freehand. Select the pencil and a color trom the 

palette. Drag the pencil to draw with the selected color. 

Paint Bucket: Fill areas with color. Select the paint bucket and a 

color from the palette, then click the space you wish to Till. 

Eraser: Erases to white. Drag over the area you wish to erase. To 

erase the entire image, double-click the eraser, or choose Clear 

from the Edit menu. 

Hand: Reposition an image. Drag to move the image in the frame. 

Eyedropper: Use a color from the picture. Select the eyedropper 

and the color on the picture. Then, select the pencil or paint bucket 

to use that color (color version only). 

= To import a picture that you have cop:.d to the Clipboard, choose 

Paste from the Edit menu. You will see the Import Picture dialog 

box (page 21). 

Remove Kid 

To remove a kid, select the kid's icon on the Kids Card, then choose 

Remove Kid from the Kid menu. 

If you are running System 7, you must decide what to do with the 

child's documents (if any have been created with an application): 

= To delete both the child and documents, click (_Betete_}. 

= To delete the child but save the child’s documents, click Gestten). 

The documents will be placed in a folder with your child’s name 

on the Macintosh desktop. You can then move or delete them 

individually, using the Finder. 
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Adult Section 

Kid Menu 

Kid Settings 
(includes Guest settings) 

Kid Settings: To edit settings (such as name, icon, and Welcome 

Message) for a kid who already appears on the Kids Card, double- 

click the kid's icon; or select the kid's icon, then choose Kid Settings 
from the Kid menu. 

You will see the Kid Settings dialog box, which functions the same 
as the Add Kid dialog box (pages 20-22). 

Guest Settings: To edit the Guest settings, double-click the Guest 

icon; or select the Guest icon on the Kids Card, then choose Kid 

Settings trom the Kid menu. 

= Jo remove the Guest icon from the Opening Screen of the Kid 
Section, click @ Disabled. 

= To show the Guest icon on the Opening screen, click @ Enabled . 

You may wish to leave the Guest icon enabled, so that visiting 
friends can use KidDesk without disturbing your child’s calendar, 
applications, etc. 

= To record a Welcome Message for the Guest, click{_ Record], 

Limit Applications 
When you add an application to KidDesk, it is automatically 

placed on all kids’ desks. To restrict a specific child's access to any 
applications that you have added to KidDesk, select the child’s icon 
on the Kids Card, then choose Limit Applications from the Kid menu. 

= To hide an application on the kid’s desk (and restrict access), select 
the application, then click(___Hide 

# Jo show an application that has been hidden, select the 

application, then click{____ Show 



Adult Section 
Kid Menu 

: 

Detach 

ES 

r Note to Grand... Painting 

Kid’s Documents 
(System 7 or later required) 

KidDesk organizes the documents that your child creates while 

using applications run from KidDesk. These Tiles may be text or 

graphics (such as files created in a word processor or paint 

program), or they may occasionally include other data (such as 

preferences files). The documents are displayed when your child 

clicks the icon of the application that created them. 

To delete or remove documents from a kid’s document list, select 

the kid’s icon on the Kids Card, then choose Kid’s Documents. 

= To permanently delete a document, select the document, then 

click (_betete_} 

= To separate a document from KidDesk, select the document, then 

click {Detach |. The document will no longer appear in your child's 
document list, and it will no longer be accessible from KidDesk. 

Detach does not delete a document, it merely “disconnects” the 

document from KidDesk. 

You may wish to detach a document if it does not belong to your 

child (for example, a document created by another child while 

using your child’s name), or if your child has no reason to open 

the document (for example, a preferences Tile). 

= To add an existing document to your child’s document list: 

1. Open the KidDesk folder on the Macintosh desktop. 

2. Open the KidDesk f folder (inside the KidDesk folder). 

3. Open the Kids f folder (inside the KidDesk f folder). 

4. Drag the document (alias of the document) into the 

folder with your child's name. 



Hpplication 

Add Applications... 

Remove Application 

Application Settings... 

MacintoshHD 

The applications 
on your hard 
disk will appear 
here. 

Advanced Options 

| | Run with Finder™ Active 

CL] Don’t Collect Documents 

| | 

Adult Section 
Application Menu 

Application Menu 
Click the “Applications” tab to see the Applications Card (if it is not 

showing) and to use the Application menu. 

Add Application 
To add applications to all kids’ desks, choose Add Applications from 

the Application menu. Caution: In choosing applications to add, be 

aware that through the menu items of some applications, your children 

can access documents you have created using other applications. 

= To select applications trom a different drive, click (_orwe_), 

= To add an application, select the application's name, then 

click (aa). To add several applications, hold the Command 3 
key while you click to select the applications. 

# To add all applications, click _ then click Csea_). 

Remove Application 
To remove an application trom KidDesk, select the application's icon 

on the Application Card, then choose Remove Application from the 

Application menu. The application will no longer be accessible from 

KidDesk. (To restrict a child's access to an application, use Limit 

Applications page 23, trom the Kid menu.) 

Application Settings 
To change application settings, select the icon on the Applications 

Card, then choose Application Settings from the Application menu. 

# To enter a new name, type the name. The application will be 

renamed in KidDesk, but will not be renamed on your hard disk. 

= To allow the application to run with the Finder active (System 7 or 

later required), click the check box. Caution: With the Finder active, 

Apple menu items and Finder functions are accessible, and the child 

can access the Macintosh desktop while using that application. 

# To turn document collection off for the application (System 7 

or later required), click the check box: KidDesk will not collect 

documents that your child creates. 

& 



Adult Section 
Options Menu 

Options 

Adult Password... 

Screen Saver... 

Kid Exit Option... 

Time Reminder... 

KidDesk ACCessories... 

off 

@® On After] 

() Don’t Allow Exit 

©) Allow Exit to Finder 

@ Allow Shut Down 

Options Menu 
Changes you make using the Options menu (which include 

Adult Password, Screen Saver, Kid Exit Option, Time Reminder, 

and KidDesk Accessories) are global. They will affect all kids 

using KidDesk. 

Adult Password 
To increase security, you can add a password for entering the Adult 

Section (in addition to Option-Command-A). 

= Choose Adult Password from the Options menu. 

= Type the password. Be sure to write it down. You will need it to 

enter the Adult Section. 

= To change or remove a password, choose Adult Password and 

either edit or delete the current password. 

Screen Saver 
To control the Screen Saver, choose Screen Saver. By displaying a 

moving image, the Screen Saver helps to protect your monitor from 

“burn in.” | 

= To turn the Screen Saver off, click “Off.” 

= To turn the Screen Saver on after a number of minutes, click 

“On After” and enter 1-99 minutes. The Screen Saver will activate 

after that interval without mouse or keyboard activity. 

= To turn the Screen Saver sound on/off, click the “Sound On” 

check box. 

Kid Exit Option 
To control how children exit from KidDesk, choose Kid Exit Option. 

= To select an exit option, click your choice. (This choice determines 

the icon on the Opening Screen.) 
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@ Record Sounds with Microphone 

Adult Section 
Options Menu 

Time Reminder 
(System 7 or later required) 

To enter a written Time Reminder that will appear on your child’s 

screen, choose Time Reminder from the Options menu. The 

reminder will even appear while your child is running another 

application trom KidDesk. 

= To enter a message, type it in the message box. 

= To turn the reminder off, click “Off.” 

# To set the reminder to appear at a regular interval, click the 

pop-up menu * and drag to the desired number. The reminder 

will continue to appear at that interval until it is turned off. 

= To set the reminder to appear at a specific time of day, click the 

hour and minute arrows. 

KidDesk Accessories 
To place accessories on or remove accessories from all desks, 

choose KidDesk Accessories from the Options menu. 

= To place an accessory on or remove an accessory from all desks, 

click “On” or “Off.” 

# To turn Calendar printing and Clock speaking on/off, click the 

appropriate check boxes. 

= To set the Phone to play a variety of greetings, click “Use Built-in 

Sounds.” To set KidDesk to record your own sounds, click “Record 

Sounds with Microphone.” 



KidDesk for Special Needs Users 

KidDesk supports single switch forms of entry (scanning). When scanning is turned on, the user can 

operate most KidDesk functions with a single click from a mouse, TouchWindow screen, or a single 

switch device. In scanning mode, “hot spots” (those areas upon which a click has some effect, such 

as the KidDesk accessories, Stop Sign, etc.) are automatically highlighted in a regular sequence. A click 

selects the highlighted hot spot. (See Add Kid, page 20, for information about enabling scanning and 

controlling the scan rate and scan progression.) 

a While KidDesk is set to scanning mode, you can turn scanning off and back on by holding down 

the Option and Command & keys while you press “S." 

Scan Progression 

In the Add Kid and Kid Settings dialog boxes (see pages 20 and 23) you may choose between two 

kinds of scanning: 

» When Automatic Progression is on, scanning begins automatically. The user clicks to select the 

highlighted hot spot. 

= When Automatic Progression is off, scanning begins after the user clicks once. A second click selects 

the highlighted hot spot. A third click begins scanning again. 

Scanning and the KidDesk Features 

Most of the KidDesk accessories and features function normally when scanning is on. However, 

three features change: 

ws The Time Reminder is disabled. 

= The Recorder on the desk is not scanned (but the Phone is scanned). Two options are available: 

(1) Set the Phone to play a variety of greetings; (2) Record a message by turning scanning oft 

(using Option-Command-S), recording as you normally would, then turning scanning back on 

(using Option-Command-S). See KidDesk Accessories, page 27, for details. | 

= The Calendar displays only the current date (and a note and reminder sticker, if they have been 

entered for that date). To enter a note or reminder sticker, first turn scanning oft (press Option- 

Command-S), then click the Calendar to enter them as you normally would (page 16). 

Simplifying the Screen 

All of the KidDesk accessories, calculator buttons, reminder stickers, etc. are large and designed for 

clarity and ease of use. If you wish to further simplify the screen, you can remove accessories using 

KidDesk Accessories from the Options menu (page 27). 

i 
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Picture Frame 

Picture Frame 

The Picture Frame, with its Welcome Message, offers you a 

means to enhance your child’s self-esteem with a verbal “pat on 

the back.” It also allows you to leave reminders of assignments 

or appointments. The Welcome Message is recorded in the 

Adult Section and is played each time your child enters the desk 

and each time the Picture Frame is clicked. (You must have a 

sound-input device to record.) 

acord Encouragement or Thanks 
s The picture you painted is great! Would you do another? 

m Hi! You're becoming a computer expert. 

a Thanks for being so helpful this week. It meant a lot to me. 

Record an Audio Fortune Cookie 
| Your mind is full of great ideas—use them! 

. fun and interesting challenge awaits you. 

# Success is headed your way. 

# This is going to be a terrific day! 

Record Assignments or Reminders 
= Please take a few minutes to write a thank-you note to grandmother. 

= Remember to practice your flute. 

y to write a poem today. 

ease put your clothes in the laundry basket. 



Calculator 
Calculator 

By allowing your child to quickly see results, a calculator can 

be a valuable tool in recognizing numerical relationships and 

in developing mathematical skills. The activities suggested here 

will help your child become accustomed to the keys and display 

window, practice skip counting, and use the Calculator to 

solve problems. 

Turns Skip Counting 
Use the KidDesk Calculator to count by 2s, 3s, 5s, 

etc. For example, enter 3 + 3 = = = to count by 

threes. Continue to press the equal sign as your 

child guesses the next number in the series. 

ater-Than and Less-Than” 
Have your child use the Calculator to solve 

problems like “What number is 6 more than 11?” 

or “What number is 5 less than 20?” 

te Problems for Each Other! 
Jake up story problems for your child. For example, “How many hours 

have you been alive?” You can add to the Tun by letting your child make 

up problems for you, then your child can use the Calculator to check 

your answers. 



Clock 

The KidDesk Clock can help your child learn to read both a 

digital and an analog clock. If your child has not yet learned 

to read the time, hearing the time spoken while viewing the 

display is an excellent way to increase both numeral and time 

recognition. Viewing the digital and analog clocks together 

will help your child learn how to read an analog clock. 

Practice Counting by Fives 
the gadget, the circus, or the dinosaur desk, watch 

second hand move around your KidDesk Clock. As It 

eaches the appropriate number, count by Tives. 

ime Interesting Things 
ong does it take a friend to sharpen a pencil? 

= How many times do you blink in a minute? 

# How long does it take to write your name? 

= How fast can you say “Mississippi” five times? 

Sharpen a Child’s Time-Telling Skills 
Have your child look at the analog clock 

he desk and say the time aloud. Then, 

the clock to check the time against 
igital display and spoken time. 



Phone & Recorder 

# French - Bon jour 

a |tallan - Buon giorno 

# German - Guten Tag 

# Spanish - Hola 

Phone and Recorder 

Both kids and adults can use the KidDesk Phone and Recorder to 

leave messages or entertaining comments. By leaving themselves 

messages, kids can take responsibility for remembering activities 

and planning ahead. (You must have a sound-input device 

to record.) 

Can Record Messages for 
iemselves or for Each Other 
riendly notes 

# Helptul reminders 

= Tongue twisters 

= Theme music or singing 
p Your Child Record a \Viessages using different voices 
ssages in Other Languages 

an Encyclopedia 
to Find Fun Facts to Record 
= A camel Is born without humps. 

# Your skin weighs about ten pounds. 

# You blink 5,000 times a day. 

# Hummingbirds can fly backwards. 

# Butterflies taste with their feet. 

= Pigs can get sunburned. 



Calendar 

ie The KidDesk Calendar can be used as an appointment calendar 

and a diary. Through use of its reminder stickers and notes, the 

Calendar accommodates both readers and non-readers. It can 

be used for a wide range of educational activities. For example, 

children can learn the order of the months, learn to plan ahead, 

or keep track of the weather. Parents can use the Calendar’s notes 

and stickers to encourage their children. 

e Encouraging Notes or Stickers for Your Child 

_ ff your child can read, write notes like “Thank you for the painting!” or 

"Great job at school!” Brighten your child's day by leaving sunshine, 

heart, or star stickers on the calendar. Positive reinforcement enhances 

self-esteem and is a wonderful motivator! 

ults Can Leave Reminders for Their Children 

he beginning of the week, write notes or leave reminder 

ers for each day of the week ahead. Then, each day 

when your child uses KidDesk, a new message will appear 

on the desk. 

Help Your Child Learn the Order of the Calendar Months 

the names of the months as your child clicks the arrow. Then switch 

so your child reads the month while you click the arrow. 



rk special occasions. 

ep track of the weather. 

Mark activities for the week ahead. 

# Remember appointments and assignments. 

Kids Can Keep a Mini-Diary and Print It Out 
Write brief descriptions of fun events and other activities. 

Record feelings, too. Add stickers to represent special days. 

Then, print out your diary each month. 

AUGUST 
SUNDAY MONDAY TUESDAY WEDNESDAY THURSDAY FRIDAY 

| played soccer and Remember to write a 
scored a goal! thank-you note to 

grandmother. 

| saw a shooting star! 

Orthodontist Dad added the 
2:30 p.m. Calculator to my desk 

today! 

| First day of school. 

n-Readers Can Use the Reminder Stickers to 

1992 
SATURDAY 

| really liked the 
painting you gave me! 

-Mom 

1S ‘s 
Sleepover at Pat's. 



From Their Desks... 
to You rs! Donna Stanger Paul Elseth SeottClough Tad Wood 

In 1980, Donna (then a teacher for 17 years) received a federal grant to develop software. She 

wanted to create programs that would challenge children to think, learn, and use the computer as 

a tool. After initial designs caused professional programmers to say, “We can't do that,” she headed 

for the local high school, recruited a few talented students, and started developing. Since then, this 

group has published over 40 products for schools and has won dozens of major educational sottware 

awards. With KidDesk, they begin a new adventure—creating software for both school and home! 

Donna is a longtime student of 
how learning takes place. Ease of 
use, simplicity, and smiles are her 
design signature. We are convinced 
that a part of her will never grow up. 



Troubleshooting 
Problem 

Sound Is barely audible or 
too loud. 

KidDesk does not display 
color on a color monitor. 

Printing icon does not 
appear in Calendar. 

Calendar does not 

print properly. 

A KidDesk accessory does 
not appear on the desk. 

Wrong Calendar date or 
Clock time appears. 

Application does not appear 
on your child’s desk. 

No Recorder on desk. 

Possible Cause 

Speaker volume is set too low 
or too high. 

Monitor is not set to 256 Colors. 

(KidDesk uses grays on 16-color 
monitors.) 

Hardware is not capable 

of 256 Colors. 

KidDesk is installed as black 

and white. 

“Printing” is turned off. 

Printer is incorrectly attached 
(will not print in any program). 

Incorrect printer is selected 
in Chooser. 

Accessory is turned off. 

Macintosh internal calendar/clock 

is set incorrectly. 

Application has not been 
added to KidDesk. 

Application has been hidden for 
this child. 

Recording is turned off. 

Your Macintosh does not 

have built-in sound input. 

Solution 

Use the “Sound” Control Panel* to set volume to 

the desired level (see Macintosh User’s Guide). 

Use “Monitors” Control Panel* to set monitor to 

display 256 Colors (see Macintosh User's Guide). 

Upgrade your video to 256 Colors. 

Re-install KidDesk (page 4). 

Click “Printing” in KidDesk Accessories dialog box 
(page 27). 

Refer to printer manual. 

Use the Chooser* to select desired printer. 

Click “On” for the accessory in KidDesk 
Accessories dialog box (page 27). 

Use the “General Controls” Control Panel* and set 

correct date or time (see Macintosh User’s Guide). 

Add the desired application using Add Application 
from the Application menu (page 25). 

Use Limit Applications from the Kid menu to 
show the application (page 23). 

Click “Record Sounds with Microphone” in KidDesk 
Accessories dialog box (page 27). 

Install a sound-input device. 

*These items (Control Panels, Chooser, etc.) are under the Apple menu. To access the Apple menu, you must be in the 

Adult Section of KidDesk. In addition, if you are using KidDesk with System 7, the Finder must be active (page 19). 

For Edmark technical support, call (206) 556-8480. 



Edmark’s Limited 90 Day Warranty 
Edmark is pleased to provide you with quality educational software. To ensure the quality of this 

program, Edmark warrants for a period of 90 days following the original retail purchase of this 

software that it is free of errors or defects interfering with program operation as described in the 

Guide. This warranty applies only to the original purchase and when the software Is used with 

the specitied equipment. | 

lf you know your disk is defective, you can request a replacement within 90 days of your purchase by 

calling our Customer Service Department at 206-556-8484, Monday through Friday, between the 

hours of 8 a.m. and 5 p.m. Pacific Time. If you are unsure whether the disk is defective, please call 

our Technical Support Department at 206-556-8480. If the problem cannot be corrected over the 

phone, we will ship you a replacement disk at no charge. Edmark’s liability is limited to the purchase 

orice of this software. No other advertising, description or representation, whether made by an 

Edmark dealer, distributor, agent or employee, is binding on Edmark or changes the terms of this 

warranty. : 

This program is for your own personal use. You may make a backup copy for safekeeping. 

However, it is against U.S. copyright laws to make copies of this disk for use by others or to” 

network the program for use on more than one computer at the same time. Your respect for the 

copyright laws enables Edmark and companies like it to continue producing quality products at 

attordable prices. 

This warranty gives you specific legal rights, and you also may have other rights which vary trom 

state to state. Some states do not allow the exclusion or limitation of incidental or consequential 

damages or limitations on how long an implied warranty lasts, so the above limitations and 

exclusions may not apply to you. | 

We are committed to providing the highest quality products and service possible, while maintaining 

our prices at affordable levels for you and your children or students. If you damage your program 

disk at any time, we will send you a replacement for a materials and handling fee of $10, as long 

as we are still manufacturing this product. Return the damaged disk, proof of purchase and 

a check to: 

Edmark Corporation 

Attention: Customer Service Department 

PO..Box 3218 

Redmond, WA 98073-3218 

The MacApp software is proprietary to Apple Computer, Inc. and is licensed to Edmark for distribution only for use in combination with KidDesk. Apple Computer, Inc. makes 
no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose. 



The People Behind the Desk... 

Lisa Adolf, Kay Allmain, Camille Ball, Aly Becker, Carolyn Bickford, Robert Bottemiller, Jeff Brebner, Harry Campbell, 

Elizabeth Casey, Jennifer Cast, Chris Chappon, Michael Cochrane, Scott Clough, Tami Cox, Gabrielle Datsko, 

Tony Duque, Larry Durbin, Paul Elseth, Kevin Field, John Forgard, Dan Friesen, Tracee Gorman, Catherine Haller, 

Monica Hanlin, Geottrey Hazel, Matt Jackson, Carol Jacobsen, Laurie Lassman, Mary Latham, Matt Lepisto, 

Kathy Linstrum, Eric Lippke, Karen Marth, Julie Martin, Tina Martin, Fred McCulloch, Margaret Monetti, John Moore, 

Ross Mortimer, Sally Narodick, Beverly Nelson, Geottrey Nelson, Duc Nguyen, Phi Nguyen, Beth Norton, Patsy Olsen, 

Winona Olson, Ju Keon Pak, Patrice Pappas, Trung Phan, Jan Pritchard, Rene Rassoulian, Robin Reichert, Tina Ruppelt, 

Neil Smith, Michael Staley, Donna Stanger, Jill Templin, Mark Tolleshaug, Gail Tremblay, Mary Ann Trower, Xang Vang, 

Liza White, Barbara Wood, Tad Wood. 
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For more information about Edmark Corporation and our products, 

write to us at PO. Box 3218, Redmond, WA 98073-3218 
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KidDesk 1.1 Update 

| This is a new, apgraded version of KidDesk. Some of the new features on 

_ your disk are not documented in the Guide. 

New Features Include: 

» Password-protected desks 

=» Secure auto-start that can be set from the Adult Section of KidDesk* 

= Document access options* 

= Disk eject options coe 2 0 
= Add Application options — 
» 16-color support ——— 

*System 7 only 

Control these features from the KidDesk Adult Section (page 18): 

Kid Passwords: You can protect each desk with a password by turning 

"Password" on in the child's Add Kid or Kid Settings dialog box (pages 20 

and 23). Then, either set a specific password by entering it in the box, or 

leave the box empty to allow the child to set a password the first time the 

desk is entered. Note: If you set an Adult Password (page 26), that password 

will work as a master kid password, allowing you to enter any password- 

protected desk or change a child's password if it has been forgotten. 

Auto-start: System 7 users can set KidDesk to run automatically each time 

the computer is turned on by choosing Startup Options from the Options 

menu, and then selecting “Startup to KidDesk." (System 7 users, please 

disregard the instructions in Step #7, page 4.) System 6 users, see Step #7 

of Installation, page 4, to set KidDesk to auto-start. 

Document Access Options: To control where your kids can open and 

save documents, choose Document Access Options from the Options 

menu. When document access is limited, kids will be able to open or save 

documents only where you have indicated. For example, you can allow 

your child to open and save documents only from floppy disks. 

= To allow kids to open and save documents anywhere on the hard drive 

or floppy disk, click “Open/Save Anywhere. " | 



= To restrict where kids can open and save documents, click “Open/Save 

Limited to." Then click to place or remove check marks in the Floppy Disk, 

Kid's Folder (each kid has a personal folder in the KidDesk folder on the 

hard drive), or Shared Folder (any folder you specify) check boxes. (An 

"X" in the check box indicates that kids can access that area.) 

Disk Eject Options: To control whether your child can eject floppy disks 

and CD-ROM discs, choose Disk Eject Options from the Options menu. 

Place an "X" in the “Display CD-ROM eject icon" or “Display floppy disk 

eject icon" check boxes to allow kids to eject disks by clicking a disk icon 

on their desks. The icon only appears on the desk if a disk is in the drive. If 

“Eject floppy disk when exiting desk" is checked, the disk in the internal 

drive is automatically ejected each time a kid exits a desk and returns to the 

Opening Screen. 

Add Application: Place applications on your child's desk by choosing Add 

Application from the Application menu. (See page 25 of the Guide for more 

information.) 

= Tosearch the drive automatically (KidDesk displays an alphabetical list of 

all applications on the drive), choose "Auto Search," and use the pop-up 

menu to indicate which drive you wish to search. Click “OK.” Then, 

follow the directions on page 25 to select the applications. 

= To search the drive manually, choose “Manual Search,” and click “OK.” 

Then, use the standard “Open File" dialog to find the application you 

wish to add. 

Having Problems? 

lf you encounter any difficulties in using the program, please refer to 

Troubleshooting in your KidDesk Guide (page 37). If that page does not 

answer your questions, you can reach Edmark's Technical Support Team 

at (206) 556-8480. 
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